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Tutorial - Getting Started with Natural

This tutorial is designed to provide a basic understanding of specific features of the Natural programming
environment and illustrates how an application can be structured as a group of modules.inténded to provide
an example of how an application should be built.

These sessions also represent a general introduction to how the editors can be used. Therefore explanations are kept
to a minimum. This tutorial isot intended to be a comprehensive description of the full range of possibilities

provided by the Natural editors. For a full description of all editor functions and features, please refer to the
corresponding sections in this documentation:

Program Editof Data Area Editof Map Editor] DDM Editor | Dialog Editor

Prerequisite:
To perform all steps of this tutorial, the database SAG-DEMO-DB must be installed and active. To start the
database, double click the SAG-DEMO-DB icon in the Natural program group.

Session 1 - Creating and Modifying a Program
Session 2 - Creating and Editing a Map
Session 3 - Checking and Running a Program
Session 4 - Creating a Local Data Area
Session 5 - Creating a Global Data Area
Session 6 - Creating an External Subroutine
Session 7 - Invoking a Subprogram

Session 1 - Creating and Modifying a Program

In this session, you will create and save a Natural program, using the program editor to enter source statements in a
program editor window.

Step 1

Natural user-written applications are stored in libraries. It may be necessary to move from one library to another in
order to perform a maintenance function or work on a different application. The application created in these sessions
will be stored in the SYSEXPG library.

Select the SYSEXPG library node in the library workspace

» To open the library SYSEXPG

1. From the tree view, choose "System Libraries".
2. Scroll to SYSEXPG and select it.
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Session 1 - Creating and Modifying a Program Tutorial - Getting Started with Natural

Step 2

Natural offers two modes of programming: structured mode and reporting mode.

Software AG recommends that you use structured mode exclusively, because it results in more clearly structured
applications. Therefore all explanations and examples in this chapter refer to structured mode. Any properties of
reporting mode will not be taken into consideration. You must be operating in structured mode to work through the
sessions in this chapter.

If the current mode is reporting mode, change it to structured mode:
» Todoso

1. From theTools menu, choos8ession Parameters Compiler options.
2. Select "Structured Mode".
3. Choos&©K.

Step 3

The SYSEXPG library should include the program used in this session, PGMOL. In this step, you will either edit or
create the program.

Edit PGMO1

If PGMOL1 is available, edit the program.

» To open PGMO1 for editing

® Expand the library node, expand the "Programs” node, select the Program PGMO1 and press ENTER.
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Tutorial - Getting Started with Natural Session 1 - Creating and Modifying a Program

Create PGMO01

If PGMOL is not available, you can create it.

» To open a new program editor window

® Open the context menu of the "Programs" node and seleldethiéem.
The program editor window is displayed:

! Untitled1 - Program

ooo | | ?

(N o

» To modify "Program Editor Options"

If line numbers are not usable, you can modify them.

1. From the main menu bar sel&cibls > Options > Program Editor.
2. Set "Line Numbers" check box.

Step 4

» To save the program under the name "PGMO01"

1. From theéDbject menu, choos8ave

If the program already exists in the library, then it is saved. Go to Step 5.

If the program does not yet exist in the library, the "Save as" dialog box appears.
2. In the "Name" text box, enter "PGMO01".
3. Choos®©K.

The program is now saved under the name "PGMO01" in the library SYSEXPG.
Step 5
» To close PGMO1 before ending the session

® From theObject menu, selectloseor presCTRL-F4.

End of Session 1.
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Session 2 - Creating and Editing a Map

The Natural map editor is used for creating the maps referenced in a Natural program. Once a map has been created,
it can be stored in the Natural system file, where it can be invoked by a Natural program using a WRITE or INPUT
statement.

A map consists of fields. A field can be a text field (a constant) or a data field (a variable), or any of the graphical
user interface elements provided in the map editor’s "Insert” menu. The fields that comprise a map can be defined
direct in the map editor window, or imported from another source object, such as a DDM, a program, or a data area.
Natural system variables can be imported as well.

In this session, you will create a map that contains text fields, data fields, and system variables.

Step 1

In the previous session, the screen prompting for an employee name was produced through the INPUT USING MAP
statement using MAPO1. In this session, you will create the map. Note that in the INPUT USING MAP statement,
the map must be specified in quotation marks to distinguish the map from a user-defined variable.

» To open a new map editor window

® Open the context menu of the SYSEXEVT node and seledtaive> Map item.
The map editor window appears.

=i Untitled? - Map =] E3

' Name: [None Selected] | Row: 0 ' Col: 0 ' Len: 0 ' Format:

<] | Ay

Step 2

A text field is a constant that you create using the text field entry im$leet menu, or that you import from another
Natural object. Its format is always A (for alphanumeric).

You can create a title for the map by drawing a text field and defining the text it will contain.

» Todoso

1. From thdnsert menu, choos&ext Constant
Or click theText Constanttoolbar button.
2. Place the text field at the top of the editor, where you want the field to begin.
3. Draw a field by holding down the left mouse button and dragging the mouse to the right about half the width of

the editor.
The text field you have just drawn is still selected. When a field is selected, its field handles appear.

The field must be selected before you can perform many of the map editor functions, such as defining a field and
selecting a color for the field.

¥ To define the text field
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Tutorial - Getting Started with Natural Session 2 - Creating and Editing a Map

1. Point to the field and double-click.
Or, from theField menu, choosBefinition.
In the text field, you can now enter the text.
2. Type "SOFTWARE AG EMPLOYEE INFORMATION".
Select the field again by clicking the mouse with the pointer outside the field and then with the pointer on the
field.
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¥ To select a color for the text field

1.

From the&Field menu, choos€olor.
Or click theField Color toolbar button.

. Select any color you want for this field. (Click the name of the color Opitien button.)
. Choosé©K.

"SOFTWARE AG EMPLOYEE INFORMATION" appears on the map in the color you selected.

. To deselect the field, move the pointer away from the field and click.

The field handles disappear.

Step 3

Natural system variables can be imported into a map. The system variables *DATX and *TIMX display the current
date and time, when the program that invokes the map is executed.

» To import the *DATX system variable

NoogkrwdpE

From thdnsert menu, choosénport .
Chooseystem variable The "Import System Variable" dialog box appears.
Scroll to *DATX and select it.

. Choosémport . The system variable will appear in the top left corner of the map.

Choos&uit to close the dialog box.
Move the *DATX field cursor below SOFTWARE AG EMPLOYEE INFORMATION.

. Select a color for the *DATX field.

Import the *TIMX system variable. Use the same procedure you used to import the *XDATX system variable.
Select a color for the *TIMX field, then move *TIMX to the line below *DATX.
The map should now look as follows.

& Untitled? - Map M=] E3

| Name: [None Selected] | How: 0 | Col: O | Len: D | Format:
“"S0FTWARE AG EMPLOYEE IHFORMATION" :
YY¥-MH-DD
TT=TT:=TT

RN a2y

Step 4

New fields can be created by copying and redefining existing fields.

»

To copy a field to the clipboard

1. Select the text field "SOFTWARE AG EMPLOYEE INFORMATION".
2. From theEdit menu, choos€opy.
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Tutorial - Getting Started with Natural Session 2 - Creating and Editing a Map

» To paste the copied field into the map

1. From theedit menu, choosPaste

2. Drag the copied field from the top left corner to below the *TIMX field.
Notice that this field is the same color as the field you copied. If you want to change its color, fFeetcthe
menu, selectolor.

» To define the new field in the "Text Field Definition" dialog box

1. Point to the field and double-click.

Or, from theField menu, choosPefinition.

In the text field, you can now enter the text.
2. Type "PLEASE ENTER STARTING NAME:".

Step 5

A data field is a field that you create using the Data field entry in the "Insert" menu, a field that you import from
another Natural object, or a Natural system variable.

In this step, you will draw a data field and define its attributes.

» To draw the data field

1. From thdnsert menu, choosBata Field.
Or click on thedata field drawing tool toolbar button.
2. Place the data field to the right of PLEASE ENTER STARTING NAME:
3. Draw a field that is 20 characters long. (Using the mouse, drag the data field across the map until Len=20).
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» To define the data field

1. Point to the field and double-click.
Or from theField menu, choosPefinition.
The "Field Definition" dialog box appears:

Field Definition ]|
Field:  |FETEY Ok,
Faorrat: le'-. vI Lenagth: |2EI Bl |EI Cancel

Fules: 0O Mode: Undef ™ Awray

Bay..

a0 DLMFHT"! Eb: I vl Ch: I ,I STy
Cy: | Di: I - I Attributes. .
= I Help
EM: |

Help Routine: I

HHelm Barameterns: I

2. In the "Field" text box, delete the name and type in "#NAME-START". Press the TAB key.

Format "A" (alphanumeric) is the correct format for this field.
The alphanumeric length of the field should be "20". If not, use TAB to move the cursor to the "Length" field

and enter "20".
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» To specify attributes for the data field

1. Chooséittributes.
The "Attribute Definitions" dialog box appears.

2. Select the "I/O Characteristics" list box and select "Output, Modifiable" to define the field as an output field that
can be modified.

3. Enter underscore () as filler character.
This is the character that is used to fill any empty positions in input fields in the map, allowing the user to see

the exact position and length of a field when entering input.
4. Choos®K.
The "Field Definition" dialog box is displayed again.
5. Choos&K to save the data field definition that you entered.
The map could now look as follows:

## Untitled2 - Map M= E3
| Name: [None Selected] | Row: 0 ' Col: 0 ' Len: 0 ' Format:
“SO0FTWARE AG EMPLOYEE IHFORMATION™ j
YY-MH-DD
TT=TT:=TT
Flease enter starting name: KEEXENNEEEASEREERNER
4 vl
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Session 2 - Creating and Editing a Map Tutorial - Getting Started with Natural

Step 6

In this step, you will edit the map to add an ending name for a range of employees.

In the same way as you have created text fields and data fields so far, draw and define another text field and another

data field.

» To draw and define the "PLEASE ENTER ENDING NAME:" text field

1. Choosénsert > Text Constantto create the text field and draw a field 25 characters long, one line below
"PLEASE ENTER STARTING NAME:"

2. In the text field, enter PLEASE ENTER ENDING NAME:
3. Select a color for the text field.

» To draw and define the data field "#NAME-END"

=Y

. Choosénsert > Data Field to draw a field 20 characters long, one space to the right of the text constant.
In the "Data Field Definition" dialog box, enter "#NAME-END" as the field name (the format is "A" and the
length is "20").

. Chooséttributes and select "Output, Modifiable" as the I/O Characteristic.

. Choos®K twice.

. Select a color for the "#NAME-END" data field.

N

g b~ W

The output of this data field is a user-defined variable found in the DEFINE DATA statement of PGMO1 that will
correspond to the new field definition entered on the map.

Step 7

» To center the field "SOFTWARE AG EMPLOYEE INFORMATION" at the top of the map

1. Select the field.

2. From therield menu, choosAlignment.

3. From the cascading menu, chobk center.
The text moves to the center of the map.

» To move fields to different locations in the map:

1. Move the "*DATX" field to the top line of the map (Row=1).
2. Move the *TIMX" field to line three (Row=3), directly below the "*DATX" field.
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Step 8

In this step, you will move ranges of fields to new locations.

» To position the first range of fields

1. Select a range of fields that contains the text field "PLEASE ENTER STARTING NAME:" and the
"#NAME-START" data field.
Select the fields by holding down the left mouse button and dragging the mouse to surround the fields. Release
the mouse button to select the fields.

2. Move the range to line five of the map (Row=5).
Move the range by placing the selector tool within the field handles and dragging the range to the new location.

» To position the second range of fields

1. Using the same method as above, select the text field "PLEASE ENTER ENDING NAME:" and the data field
"#NAME-END".

2. Move the range to Line Seven of the map (Row=7).
The map now looks as follows.

# Untitled? - Map [_ O] =]

' Name: #NAME-END 'Row:7 | Col:30 | Len:20 | Format:
Y& -HH-DD “SO0FTWARE AG EMPLOYEE IHFORMATIOH™ j
TT:-TT:=TT

Please enter starting name: KERXXERNERNAERNEENNN

O m| |
Please enter ending name:sXXXiXiXEXANENKRANANKE
O u m

A 2w

Step 9

The first time you save a map, you must give it a name. After the map is named, you can make changes to it and save
it or stow it without entering the name. If you want to save a modified map with a different name, choose "Save as"
and enter a different name.

» To save the map and give it a name

1. From theDbject menu, choos8ave As

The Save Asdialog box appears. The current library is SYSEXPG, the library where the map is saved.
2. In the "Name" text box, type "MAPO1".
3. Choose&ave

The map is saved as MAPOL1 in the SYSEXPG library.
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Step 10

Now, you will create a processing rule for a map field.

» To define a processing rule for the #NAME-START data field

1. Click the #NAME-START field once to select it.

2. From thd~ield menu, choosRules
The "Field Rules" dialog box appears.

3. Choose&Create.
A program editor window opens. Enter the following processing rule:
IF & =’ REINPUT 'PLEASE TYPE IN A NAME’
MARK *&
END-IF
*

Note:
The ampersand (&) in the processing rule will be dynamically replaced by the name of the field.

» To save the processing rule and give it a rank

1. From theDbject menu, choos8ave asThe "Rule Selection" dialog box appears.

2. From the list box, select "1", and then chcOg&e

3. Close the "Map Rule" (program editor) window by choo€§ifagefrom theObject menu.
The window closes and MAPO1 reappears.

Step 11

In this step, you will test MAPOL1 to check whether it works as intended.

» To test the map

1. From theéDbject menu, choos&est
The map, including the processing rule, is executed. This is the same screen that appears when the map is

invoked from PGMO1:

#® NATURAL =] B3

o7-12-m1 "SOFTWARE AG EMPLOYEE THFORMATION®
18:18:15

Please enter starting name: _

Please enter ending name:

Enter | Test | Test | Test | Test | Test | Test | Test ﬂ

2. Type in a name and press ENTER.

You are returned to the map editor.
When you do not enter a name and press ENTER, the message "Please enter starting name" is displayed in the

message line.
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Step 12

When the map has been successfully tested, it has to be stowed; that is, stored in both source and object form.

» To stow the map

From theObject menu, choos8tow.

Step 13

The next step is to create a helproutine and attach it to a field in a map.

» To modify the field definition for the field "#NAME-START"

1. Select the field "#NAME-START".

2. Either seledDefinition from theField menu or point to the "#NAME-START" field and double-click.
The "Field Definition" dialog box appears.

3. Use TAB to move to the "Help Routine:" text box, and enter "HELP0OO1™ (do not forget the quotation marks).
"HELPOO1" (which is yet to be created) is the name of the helproutine that is invoked when a user presses the
HELP key while the cursor is in the "#NAME-START" field.

4. ChooseK.

The map editor window appears.
5. Stow the map (that is, store it in source and object form) by chddgingrom theObject menu.
6. From theDbject menu, choos€lose
Step 14

Now the helproutine itself has to be created.

» To create the helproutine

Open the context menu of the "SYSEXEVT" node and seledt¢ine> Helproutine item.

End of Session 2.
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Session 3 - Checking and Running a Program

In the previous session, you added a variable called #NAME-END to MAPOQ1. This variable allows the program to
provide an ending point for the READ statement. Otherwise, all employees from JONES to the end of the alphabet
would be included in your report.

Now that the map allows both the beginning and ending name to be provided on the input screen, an IF statement
must be added to the PGMO1 program.

Step 1

Make sure that SYSEXPG is the current library.

In the "Programs" folder, scroll to "PGMO01" and select it.

The program editor is invoked and the current version of the program PGMO1 appears.

For easier editing, you can maximize the program editor window by clicking the "Maximize" button.
Step 2

The program includes the following statement:

| MOVE #NAME-START TO #NAME-END

Replace this statement with the following IF statement:

IF #NAME-END ="~
MOVE #NAME-START TO #NAME-END
END-IF

Step 3

You can add user comments to a program to identify the program modifications that you have made. A user
comment helps anyone editing or maintaining a source program and is ignored during processing.

A user comment is entered by inserting a statement line or lines. If the entire line is to be reserved for a user
comment, enter an asterisk and a blank (* ) or two asterisks (**) in columns 1 and 2 of the line and type in the
comment. If you want to place a comment in the same line of source code, separate the code from the comment with
" [** (a blank, a slash and an asterisk).

Add a comment to Line 3 to indicate that the program has been modified, for example:

* A BEGINNING AND ENDING NAME ARE USED FOR THE OUTPUT
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Step 4

Session 3 - Checking and Running a Program

When you have completed the above modifications to PGMO01, the program should look as follows:

*PGM-ID: PGMO1
*FUNCTION: DEMONSTRATE NATURAL PROGRAM CREATION
* A BEGINNING AND ENDING NAME ARE USED FOR THE OUTPUT

*

DEFINE DATA

LOCAL

01 #NAME-START (A20)
01 #NAME-END (A20)
01 #MARK (A1)

01 EMPLOYEES-VIEW VIEW OF EMPLOYEES
02 PERSONNEL-ID  (A8)

02 NAME (A20)
02 DEPT (A6)
02 LEAVE-DUE (N2)

END-DEFINE

*

REPEAT

*

INPUT USING MAP '"MAPOQO1’
*
IF #NAME-START ="
ESCAPE BOTTOM
END-IF
*
IF #NAME-END ="~
MOVE #NAME-START TO #NAME-END
END-IF
*
RD1. READ EMPLOYEES-VIEW
BY NAME
STARTING FROM #NAME-START
THRU #NAME-END

IF LEAVE-DUE >= 30

PERFORM MARK-SPECIAL-EMPLOYEES
ELSE

RESET #MARK
END-IF

DISPLAY NAME 3X DEPT 3X LEAVE-DUE 3X '>=30" #MARK

*

END-READ
*
IF *COUNTER (RD1.) =0
REINPUT 'PLEASE TRY ANOTHER NAME’
END-IF

*

END-REPEAT

*

DEFINE SUBROUTINE MARK-SPECIAL-EMPLOYEES
MOVE ™ TO #MARK

END-SUBROUTINE

*

END
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Save the modified version of PGMO1 by choosing "Save" from the "Object" menu.

Step 5

Checking a program allows you to find and correct syntax errors that would otherwise prevent the program from
being compiled. In this step, you will create an error in the source code of PGMO1. Then you will check the program
to identify the error, correct the error, and run the program.

¥ To create an error in the PGMO1 source code

1. Edit PGMOL.
2. Use the arrow keys or tieo to function of theEdit menu to move the cursor to the following line:
DISPLAY NAME 3X DEPT 3X LEAVE-DUE 3X ">=30' #MARK

3. Move the cursor to the second quotation mark and piesso remove the quotation mark.
Natural uses beginning and ending quotation marks to designate text strings. A text string must be closed on the
same line in which it was opened. When the Natural compiler finds an odd number of quotation marks on the

same line, then it reports a syntax error.

4. From theDbject menu, choos€heck.
When the error is detected, syntax checking is suspended. The line that contains the error is displayed, and the

following error message appears:
NAT0305 TEXT STRING MUST BEGIN AND END ON SAME LINE

» To correct the error and check the program again

1. Add an quotation mark directly, and pressG@NTINUE button.
Or pres€ENTER to return to the program editor and make the correction.

2. From théDbject menu, choos€heck
When the syntax error has been corrected, and if no other syntax errors are detected, you are informed that the

check was successful.
3. ChooséK.

Step 6

In this step, you will run the program PGMO01 and view the output. When you run this program, you are prompted to
enter a name. The EMPLOYEES file is searched to locate all employees with that name; then a report that includes
the Name, Department and Leave Due to each employee with that name is displayed. The names of employees who
have 30 or more days leave due are marked with an asterisk.

The prompting screen is invoked at the INPUT USING MAP statement. The final report is formatted according to
information in the DISPLAY statement.

The processing required to show which employees have more than 30 days leave is handled in the portion of the
program starting with IF LEAVE-DUE. Those with 30 or more days of leave due have an asterisk in the final report
as a result of processing in the PERFORM statement and the DEFINE SUBROUTINE statement.
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» To see if everything - including the map and the helproutine - works as intended

1. From theDbject menu, choos&un to compile and execute the program PGMO1.
The map MAPOL1 is displayed.
2. Pres€ENTER without typing in anything.
The following message is displayed:
PLEASE TYPE IN A NAME
3. In the first input field in the map, enter a question mark (?).
The helproutine HELP0OO1 appears:
TYPE THE NAME OF AN EMPLOYEE.
4. In the first input field of the map, type the name MCKENNA, and [#BSER.
As there is no record with the name MCKENNA in the database, the following message is displayed:
PLEASE TRY ANOTHER NAME
5. In the first input field of the map, type the name SMITH, and RIER.
The database does include the name SMITH; the following list is displayed:

#® MATURAL [_ o]
Page 1 97-12-82 12:45:31
HAHE DEPARTMEMT LEAUE >=3@

CODE DUE

SHITH SALERZ 28

SHITH FINAB1 28

SHITH HEMT 81 20 *

SHITH TECH18 Y

SHITH FINAG1 20 %

SHITH TECH18 8

SHITH TECH18 8

SHITH TECH18 y

SHITH SALEZ M 8

SHITH TECHBS 8

SHITH - HGMT18 8

SHITH TECH18 y

SHITH HEHMT 38 8

SHITH SALEZ M 7

SHITH HEHMT18 8

SHITH SALE4H 8

SHITH HEHMT18 8

SHITH HEHT18 12

|

6. Pres&€ENTER.

7. When the program prompts you again for a name, enter a period (. ERTESR again to return to the
program editor window.
8. Close PGMOL1.

End of Session 3.
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Session 4 - Creating a Local Data Area

Locad

e — e
EUkBH 6N e

In Session 1, the fields used by the program were defined within the DEFINE DATA statement in the program itself.
It is also possible, however, to place the field definitions in a local data area outside the program, with the program’s
DEFINE DATA statement referencing that local data area by name. For a clear application structure, it is usually
better to define fields in data areas outside the programs.

In this session, the information in the DEFINE DATA statement will be relocated to a local data area outside the
program. In subsequent sessions, some of this information can be used as the basis of a global data area shared by a
program and an external subroutine. As you will see later in this tutorial, an important advantage of data areas is to
allow a program and its external subroutine to share the same data in a single data area.

Step 1
In this step, you will create a data area with three data fields. Each data field must be defined separately.

» To open a local data area editor window

1. From theDbject menu, choosblew.
2. From the cascading menu, chobeeal Data Area.
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» To insert the first data field

1. From thdnsert menu, choosBPata Field.
The "Data Field Definition" dialog box is displayed.

Data Field Definition |

Lewel: |1_ Add
MNarme: || Caticel
Eorrnat: I-'“-"- "I Dynamic: [~ Length: I'lﬂ fray Definition,.
Edit razk: I L

Iritialize..
Header: I

Help

Cormmert; I

In the "Level" text box the default "1" is displayed.
In the "Name" text box, enter "#NAME-START".
Format "A" is the correct format for the "#NAME-START" data field. (Alphanumeric is the default format).
In the "Length" text box, enter "20".
. ChooséA\dd.
The "Define a Data Field" dialog box appears again to allow you to define another data field.

o R wN

Define a second and third data field with the following attributes:

Field Name| Data Field 2 | Data Field 3
Level: 1 1

Field: #NAME-END | #MARK
Length: 20 1

Format: A A

When the "Data Field Definition" dialog box is displayed again, chQuseto end the field definition process.

Copyright Software AG 2001 19



Session 4 - Creating a Local Data Area

The local data area now looks as follows:

® Untitledd - Local Data Area =] E3

| Size: 291

| Line: 3 of &

Tutorial - Getting Started with Natural

Name of Data Field | F | Len | Index{C

LT

*** Top of Data Area ™
HNAME-START A
HNAME-END

#MARK A
*** End of Data Area ™

20
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Step 2

» To confirm that no syntax errors have been made

® From theObject menu, choos€heck

Step 3

Variables defined in a Natural DDM can be imported directly into the local data area.

» To import fields from the "EMPLOYEES" DDM

1. Select the "#MARK" field.
2. From thdnsert menu, choosemport .
The "Import View" dialog box appears with the name of the current library (SYSEXPG) in the "Library" list
box.
3. Open the "Library" list box and select the SYSEXDDM library.
A list of all DDMs in the SYSEXDDM library appears in the DDM list box.
4. Select the "EMPLOYEES" DDM.
A list of all the data fields in the "EMPLOYEES" DDM appears in the "Data Fields" list box.
5. Scroll through the list and select the following fields: "PERSONNEL-ID", "NAME", "DEPT", and
"LEAVE-DUE".
Note:
To select individual fields, hold dowdTRL while you click the left mouse button.
6. Choosé©K.
The "View Definition" dialog box appears.
7. Enter "EMPLOYEES-VIEW" as the name of the view.
8. Choos®©K.
The imported fields appear in the local data area, after the "#MARK" field. The name of the view that contains
these fields (EMPLOYEES-VIEW) also appears in the data area and is identified with a V in the T (Type)

column.
| Size: 776 | Line: 9 of 10
1 | T |L | Name of Data Field ' F | Len | Indexf(
* *** Top of Data Area ™*
1 #NAME-START A 20
1 #NAME-END A 20
1 #MARK A 1
¥ 1 EMPLOYEES-VIEW EMPLO
2 PERSONNEL-ID A 8
2 NAME A 20
| 2 DEPT A B
2 LEAVE-DUE N 2.0
* *** End of Data Area *™*
4| | 0
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Step 4

¥ To check the new local data area

1. From theDbject menu, choos€heck
2. If syntax errors are found, correct them; then check the local data area again.

Step 5

» To stow the new local data area

1. From theDbject menu, choos8tow.
The "Stow As" dialog box appears.
2. In the "Name" text box, enter "LDAO1".
As the library SYSEXPG is highlighted in the "Library" list box, the LDAOL local data area will be stored in

this library.
3. Choosé©K.

Step 6
» To close the LDAO1 local data area before continuing this session

® From theObject menu, choos€lose

Step 7

In this step, the PGMOL1 program is modified to reference the LDAO1 local data area. After removing the lines within
the DEFINE DATA statement that define variables, you will add a statement to reference the local data area.

» To edit PGMO1

1. Open the SYSEXPG library and then, from the "Objects" window, open the program PGMO1.

2. Maximize the program editor window for easier editing.

3. Remove the lines that define variables:
Place the cursor at the beginning of the line containing "#NAME-START" and use the mouse to select the
following text:

DEFIME DATA
LOCAL
81 #MAME-START {Azaj
81 HMAME-EHND {Azaj
81 HHARK (At}
81 EMPLOYEES-UIEW UIEW OF EMPLOYEES

82 PERSOHMEL-ID (ng)

82 MAME {Azaj

82 DEPT {AG)

82 LEAVE-DUE {H2)
END-DEF ITHE

4. From theEdit menu, choosBelete
5. Add a reference to LDAO1 by entering the following statement in the blank line after LOCAL:
USING LDAO1
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The program should now look as follows:

*PGM-ID: PGMO01
*FUNCTION: DEMONSTRATE NATURAL PROGRAM CREATION
* A BEGINNING AND ENDING NAME ARE USED FOR THE OUTPUT
* PROGRAM NOW USES A LOCAL DATA AREA
*
DEFINE DATA
LOCAL
USING LDAO1
END-DEFINE

*

REPEAT

*

INPUT USING MAP '"MAPOL’
*
IF #NAME ="
ESCAPE BOTTOM
END-IF
*
IF#END ="
MOVE #NAME TO #END
END-IF
*
RD1. READ EMPLOYEES-VIEW
BY NAME
STARTING FROM #NAME
THRU #END

IF LEAVE-DUE >= 30

PERFORM MARK-SPECIAL-EMPLOYEES
ELSE

RESET #MARK
END-IF

*

DISPLAY NAME 3X DEPT 3X LEAVE-DUE 3X >=30' #MARK

*

END-READ
*
IF *COUNTER (RD1.) = 0
REINPUT 'PLEASE TRY ANOTHER NAME’
END-IF

*

END-REPEAT

*

DEFINE SUBROUTINE MARK-SPECIAL-EMPLOYEES
MOVE ™ TO #MARK

END-SUBROUTINE

*

END
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Step 8

1. Check the PGMOL1 program and correct any errors.

2. Run PGMO1 to confirm that the results are the same as when the DEFINE DATA statement did not reference a
local data area.

3. Stow PGMOL1 so that it is available for Session 5.

4. Close PGMOL1.

End of Session 4.
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Session 5 - Creating a Global Data Area
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In Natural, data can be defined in a single location outside any particular program or routine. Data defined in such a
global data area can then be shared by multiple programs/routines.

In this session, you will create a global data area. In addition, you will modify the local data area created in the
previous session. You will also modify the program so that it references not only the local data area, but also the new
global data area.

Step 1

The local data area that you created in Session 4 (LDAO1) is stored in the SYSEXPG library. Before you start this
session, make sure that the SYSEXPG library is the current library.

You can create a new data area from an existing data area by editing the data area and saving it with a different name
and type. The original data area remains unchanged, and the new data area can be edited.

In this step, you will use the local data area LDAOQL1 to create a global data area.

Open LDAO1.

» To save LDAO1 with the name "GDAO01" and change the type to "GDA"

1. From theDbject menu, choos&ave As
The "Save As" dialog box appears.

2. In the "Name" text box, enter GDAOL.
Do not change the name of the current library (SYSEXPG). The new global data area is stored in the SYSEXPG
library.

3. Open the "Type" list box and select "Global".

4. Choos®K.
The data area is saved as a global data area named "GDAQ01". GDAO1 appears in the data area editor window.

Step 2

¥ To remove the data fields "#NAME-START" and "#NAME-END"

1. Select the fields "#NAME-START" and "#NAME-END".
2. From theEdit menu, choosBelete

Note:
To select multiple fields, hold down the left mouse button and drag the mouse across the fields to be selected.
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The global data area should now look as follows:

B GDADT [SYSEXPG] - Global Data Area [_ |O] =]
| Size: 582 | Line: 1 of 8
T | Commen [
= *** Ton of Data Area ™
1 #WABRK A 1
¥ 1 EMPLOYEES-VIEW EM
¢ PERSONMELAD A 8
2 MNAME A 20
2 DEPT A B
¢ LEAVE-DUE M 2.0
* *** End of Data Area ™*
4| | b

Step 3
The new data area must be stowed before any program referencing that data area can be compiled.
» To stow the new data area

1. Stow GDAO1 by choosing "Stow" from the "Object" menu.
2. Close GDAO1 by choosing "Close" from the "Object" menu.

Step 4

Now that the new global data area has been created, the variables contained in it must be removed from the local data
area.

Open LDAO1.
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» To remove all the data fields that are now in the global data area GDAO1 ("#MARK",
"EMPLOYEES-VIEW", and all remaining lines)

1. Select all fields except "#NAME-START" and "#NAME-END".

2. From theEdit menu, choosBPelete
The revised local data area how contains only the variables "#NAME-START" and "#NAME-END":

& LDAD1 [SYSEXPG] - Local Data Area Hi=] E3

| Size: 194 | Line: 1 of 4

: J U J Comment |J |

*** Togp of Data Area ™

1 HNAME-START A 20
1 HNAME-END A 20
* *** End of Data Area *™*
1| | »

3. Stow the revised local data area.
LDAO1 is now ready to be referenced by the program PGMO1.

4. Close LDAOL1.

Step 5

The DEFINE DATA statement in the PGMO1 program must now reference data that are located in the global data
area GDAO1 as well as the local data area LDAO1.

» To open PGMO1, and add a reference to the global data area

1. Open PGMO1.
2. Place the cursor at the end of the DEFINE DATA statement and press ENTER.
3. In the blank line created, type GLOBAL USING GDAO1 and press ENTER.
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Step 6
In this step, you will revise the output instructions in PGMOL1.

In this step, you will modify the program PGMOL1 to include a WRITE TITLE statement, which produces a
multiple-line title in the resulting report, and modify the format of the DISPLAY statement.

» Todoso

1. Insert a blank line after the following lines:
RESET #MARK
END-IF
2. Add the following WRITE TITLE statement:
WRITE TITLE
/ *** PERSONS WITH 30 OR MORE DAYS LEAVE DUE ***'
/***  ARE MARKED WITH AN ASTERISK e /4
The "/" notation indicates a line break. The title lines are centered and are not underlined.
3. Change the DISPLAY statement as follows:
DISPLAY 23X '/INAME' NAME
3X'//IDEPT" DEPT
3X'/LV/IDUE" LEAVE-DUE
3X* #MARK

The revised program should now have the changes to the DEFINE DATA, WRITE TITLE, DISPLAY statements,
and the program header (comment) as shown below.
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*PGM-ID: PGMO1
* FUNCTION: DEMONSTRATE NATURAL PROGRAM CREATION
* A BEGINNING AND ENDING NAME ARE USED FOR THE OUTPUT
* PROGRAM NOW USES A LOCAL DATA AREA
* A GLOBAL DATA AREA AND TITLE HAVE BEEN ADDED AND
* THE DISPLAY STATEMENT HAS BEEN CHANGED
*
DEFINE DATA
GLOBAL USING GDAO1

LOCAL USING LDAO1

END-DEFINE

*

REPEAT

*

INPUT USING MAP '"MAPOQO1’
*
IF #NAME ="
ESCAPE BOTTOM
END-IF
*
IF#END ="’
MOVE #NAME TO #END
END-IF
*
RD1. READ EMPLOYEES-VIEW
BY NAME
STARTING FROM #NAME
THRU #END

IF LEAVE-DUE >= 30

PERFORM MARK-SPECIAL-EMPLOYEES
ELSE

RESET #MARK
END-IF

WRITE TITLE
[ *** PERSONS WITH 30 OR MORE DAYS LEAVE DUE ***'
[***  ARE MARKED WITH AN ASTERISK e/}
*
DISPLAY 23X'/IN AM E’ NAME

3X’//IDEPT" DEPT
3X’/LV/IDUE" LEAVE-DUE
3XI* #MARK

*

END-READ
*
IF *COUNTER (RD1.) =0
REINPUT 'PLEASE TRY ANOTHER NAME’
END-IF

*

END-REPEAT

*

DEFINE SUBROUTINE MARK-SPECIAL-EMPLOYEES
MOVE ™ TO #MARK

END-SUBROUTINE

*

END
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Step 7
After you have completed all changes:

1. Check the program and correct any errors that might exist.

2. Run the program, using "SMITH" as the nhame on the input screen.

Note the differences in the report output, which should have the following format:
@ NATURAL

3. After you have confirmed that PGMO01 has no errors, stow it for future modification in Session 6 and close
PGMOL1.

End of Session 5.
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Session 6 - Creating an External Subroutine
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In Natural, a subroutine can be defined either within a program, or as an external subroutine outside the program.

Until now, the subroutine "MARK-SPECIAL-EMPLOYEES" has been defined within the program using a DEFINE
SUBROUTINE statement. In this session, the subroutine will be defined as a separate object external to the program.

Because both internal and external subroutines are invoked with a PERFORM statement, only minimal changes to
the program are required.

Step 1
In this step, you will create a subroutine named SUBROL1:

Note:
This subprogram is contained in library SYSEXPG. If you have access to this library, you do not have to perform
this step.

» To open a new program editor window

1. From theDbject menu, choosBlew.
2. From the cascading menu, cho8séroutine.
3. Enter the following statements:
* SUBR-ID: SUBRO1
*
* FUNCTION: DEMONSTRATE NATURAL
* THIS IS A SUBROUTINE

*

* ok * X

¥ To save the subroutine

1. From theObject menu, choos8ave As
The "Save As" dialog box appears.

2. In the "Name" text box, enter "SUBRO1".
SUBRO1 should be saved in the SYSEXPG library. If SYSEXPG is not the current library, from the "Library"
list box, select SYSEXPG.

3. Choos&©K.
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Step 2

In this step, you will edit the program PGMO01, copy two statements and paste them into the subroutine SUBRO1.

» To edit the program PGMO01

1.

2.

Use theMinimize button to minimize SUBRO1.
Note:
You can reopen SUBROL1 by clicking its icon or by choosing "SUBRO01" from the "Window" menu.

Open PGMOL.

» To copy the DEFINE DATA statement

1.

2.

3.

Place the cursor at the beginning of the DEFINE DATA statement and drag the mouse until the following lines
are selected:
DEFINE DATA
GLOBAL USING GDAO1
LOCAL USING LDAO1
END-DEFINE
*
From theEdit menu, choos€opy.
The DEFINE DATA statement is copied and placed on the clipboard.

Use theéMinimize button to minimize PGMO1.

» To paste the copied statement into SUBRO1

1.
2.
3.

32

From thewindow menu, choos8UBRO1
Place the cursor below the last comment line.
From theedit menu, choosPaste.
The DEFINE DATA statement appears.
Cut the following DEFINE SUBROUTINE block from PGMO01 and paste it into SUBRO1. Follow the same
procedure as above but, from teéit menu, choos€ut instead ofCopy.
DEFINE SUBROUTINE MARK-SPECIAL-EMPLOYEES
MOVE * TO #MARK
END-SUBROUTINE

*

. Paste the block below the END-DEFINE in program PGMOL.
. Add an END statement at the end of the subroutine.
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Step 3

The subroutine SUBRO1 should now appear as follows:

* SUBR-ID: SUBRO1

*

* FUNCTION: DEMONSTRATE NATURAL
*THIS IS A SUBROUTINE

*

* %k X %

DEFINE DATA
GLOBAL USING GDAO1
LOCAL USING LDAO1
END-DEFINE
*
DEFINE SUBROUTINE MARK-SPECIAL-EMPLOYEES
MOVE ™ TO #MARK
END-SUBROUTINE

*

END

1. From theDbject menu, choos€heckto check SUBRO1 and correct any errors.
2. From thédbject menu, choos8&tow to stow SUBRO1.
3. From théDbject menu, choos€loseto close SUBRO1.
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The program PGMO01 should now look as follows:

*PGM-ID: PGMO1
* FUNCTION: DEMONSTRATE NATURAL
* PROGRAM NOW USES A LOCAL DATA AREA
* A GLOBAL DATA AREA AND TITLE HAVE BEEN ADDED AND
* THE DISPLAY STATEMENT HAS BEEN CHANGED
* THE SUBROUTINE IS NOW EXTERNAL
*
DEFINE DATA
GLOBAL USING GDAO1
LOCAL USING LDAO1
END-DEFINE

*

REPEAT

*

INPUT USING MAP 'MAPO1’
*
IF #NAME-START =
ESCAPE BOTTOM
END-IF
*
IF #NAME-END ="
MOVE #NAME TO #NAME-END
END-IF
*
RD1. READ EMPLOYEES-VIEW
BY NAME
STARTING FROM #NAME-START
THRU #NAME-END

IF LEAVE-DUE >= 30
PERFORM MARK-SPECIAL-EMPLOYEES
ELSE
RESET #MARK
END-IF
*
WRITE TITLE
[ *** PERSONS WITH 30 OR MORE DAYS LEAVE DUE ***
/***  ARE MARKED WITH AN ASTERISK by}
*
DISPLAY 23X'/IN A M E’ NAME
3X’/IDEPT" DEPT
3X’/LVIDUE" LEAVE-DUE
3XI* #MARK

*

END-READ
*
IF *COUNTER (RD1.) = 0
REINPUT 'PLEASE TRY ANOTHER NAME’
END-IF

*

END-REPEAT

*

END
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Step 4

1. Check PGMO01 and correct any errors.

2. Run the program to confirm that the results are the same with an external subroutine as with an internal
subroutine.

. Stow the program for the next session.

4. Close PGMO01, saving your changes.

w

End of Session 6.
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Session 7 - Invoking a Subprogram
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In Natural, both subprograms and subroutines can be invoked from a main program.

A subprogram is invoked using a CALLNAT statement. Data are passed from the main program (the calling
program) to a subprogram through a set of parameters that are referenced or defined in the DEFINE DATA
PARAMETER statement of the subprogram.

While a subroutine such as SUBROL1 created in Session 6 shares a global data area with the main program, the
subprogram only receives data that are passed by way of a parameter list from the main program’s CALLNAT
statement.

In this session, the PGMO1 program will be expanded to include a CALLNAT statement that invokes a subprogram.
In the subprogram, the employees identified from the main program will be the basis of a FIND request to the
VEHICLES file. As a result, your report will contain VEHICLES information from the subprogram as well as leave
due, etc. from the main program.

The new subprogram will require the creation of a local data area and a parameter data area. In this case, new
variables will be defined in the main program’s local data area, and this will in turn help create the subprogram’s
parameter data area variables.

Step 1

The local data area that you created in Session 4 (LDAO1) is stored in the SYSEXPG library. Make sure that the
SYSEXPG library is the current library.

In this step, you will modify the LDAOL1 local data area to accommodate the new subprogram. The following fields
must be added to LDAO1:

#PERS-ID
#MAKE
#MODEL

These fields are referenced in the CALLNAT statement that you will add to the program PGMOL1 in a later step.

Open LDAOL1.
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¥ To add the data fields

1. Select the field "#NAME-END".
2. From thdnsert menu, choosPata Field.
The "Data Field Definition" dialog box appears.
In the "Level" text box, the default "1"is displayed.
3. In the "Name" text box, enter "#PERS-ID".
. In the "Length" text box, enter "8".
5. ChooseéAdd.
The field definition you entered is added to the LDAO1 local data area, and the "Data Field Definition" dialog
box reappears, allowing you to define the next data field.

N

» To define the two remaining fields, "#MAKE" and "#MODEL", as you defined the "#PERS-ID" field,
enter a length of "20" for each field

1. Choos&uit to close the "Data Field Definition" dialog box and return to the data area editor window.
The local data area should now appear as follows.

® LDAD1 [SYSEXPG] - Local Data Area Mi=] E3

| Size: 485 | Line: 1 of 7
J U J Comment | J
B *=* Ton of Data Area
1 HENAME-START A 20
1 #NAME-END A 20
1 #PERS-ID A 8
1 #MAKE A 20
1 #MODEL A 20
* *=* End of Data Area ™*
1| | »

2. Check and stow the LDAO1 local data area.

Step 2

With minor modifications, the LDAO1 local data area can be used to create the parameter data area that will be
needed for the subprogram.

In this step, you will delete two of the data fields in LDAO1L, then save the revised data area as a parameter data area
named PDAOQ1L. The original LDAO1 local data area remains intact. (It is also possible to define the parameter data
area directly by using the menu to choose "Object > New > Parameter data area" ).

Open LDAO1.

¥ To delete the data fields "#NAME-START" and "#NAME-END"

1. Select the fields "#NAME-START" and "#NAME-END".
2. From theEdit menu, choosBelete

» To save the data area with the name PDAO02 and data area type "Parameter”

1. From theéDbject menu, choos8ave As
The "Save As" dialog box appears.
2. In the "Name" text box, enter "PDA02".
3. Open the "Type" list box and select "Parameter".
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4. ChooséK.
Your parameter data area should now look as follows.

& PDADZ [SYSEXPGE] - Parameter Data Area =] E3
| Size: 291 | Line: 1 of 5

: J U J Comment | J

*** Top of Data Area ™"
H#PERS-ID
#WAKE

#WMODEL
*** End of Data Area *™*

5. Check the new parameter data area and correct any errors.
6. Inthe SYSEXPG library, stow the parameter data area.
7. Close the parameter data area.

Step 3

The subprogram will also use variables that are local to the program. In this step, you will create a new local data
area.

» To open a new data area window to create a local data area

1. From theéDbject menu, choosBlew.
2. From the cascading menu, chobeeal data area
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Step 4

Fields contained in any Natural DDM can be imported into a data area. In this step, you will import several fields
from the VEHICLES DDM into the new local data area.

» To import fields from the VEHICLES DDM

1. From thdnsert menu, choosémport .
The "Import View" dialog box appears with the name of the current library (SYSEXPG) in the "Library" list
box.

2. Open the "Library" list box and select the SYSEXDDM library.
A list of all DDMs in the SYSEXDDM library appears in the DDM list box.

3. Select the "VEHICLES" DDM.
A list of all the data fields in the "VEHICLES" DDM appears in the "Data fields" list box.

4. Select the fields "PERSONNEL-ID" through "MODEL" (drag the mouse across the fields to select them) and
choose OK.

5. In the "View Definition" dialog, choogek.
The fields appear in the data area window.
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The local data area now contains fields imported from the "VEHICLES" DDM as shown below:

E LDADZ [SYSEXPG] - Local Data Area M=l E3
| Size: 485 | Line: 1 of 7
J U J Comment | J |
& *** Topn of Data Area ™
V¥V 1 VEHICLES VEHICLES
2 PERSONNEL-ID A 8
G 2 CAR-DETAILS
3 MAKE A 20
3 MODEL A 20
* *** End of Data Area ™
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Step 5

¥ To save the new local data area as LDA02

1. From theéDbject menu, choos8ave As
The "Save As" dialog box appears.
2. In the "Name" text box, enter "LDAQ02".
3. Choos®©K.
The local data area is saved as LDAQO2 in the SYSEXPG library.
4. Check the new local data area and correct any errors.
5. Stow the new local data area.
LDAOQ2 is now ready for use by the subprogram.
6. Close LDAO2.

Step 6

The subprogram used in this session, SPGMO02, receives the personnel number passed by the main program
(PGMO01) and uses this number as the basis for a search of the VEHICLES file.

The SYSEXPG demo library should include the SPGMO02 subprogram.

If SPGMO2 is available, ensure that it has been stowed and then proceed directly to Step 7 (modifying the main
program) later in this session.

If SPGMO02 is not available, you can create it. Instructions are provided below.
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» To open a new program editor window to create the subprogram

1. From theDbject menu, choosBlew.
2. From the cascading menu, choBsé&program.
3. Enter the subprogram shown below:
* PGM-ID: SPGMO02
*
DEFINE DATA
PARAMETER
USING PDAO02
LOCAL
USING LDAO2
END-DEFINE
*
FD1. FIND (1) VEHICLES
WITH PERSONNEL-ID = #PERS-ID
MOVE MAKE (FD1.) TO #MAKE
MOVE MODEL (FD1.) TO #MODEL
ESCAPE BOTTOM
END-FIND
*
END
4. Save SPGMO02 and stow it.
5. Close SPGMO02.

Step 7

In this step, you will modify the main program (PGMO01) to accommodate the subprogram.

» Todoso

1. Open PGMO1.
2. Add the following statements immediately before the WRITE TITLE statement:

RESET #MAKE #MODEL
CALLNAT 'SPGM02’ PERSONNEL-ID #MAKE #MODEL

The parameters passed in the CALLNAT statement come from both the global data area and the local data area.
Also, the variables defined in the parameter data area of the subprogram do not have to have the same name as the
variables in the CALLNAT statement. Because the parameters are passed by address, it is only necessary that they
match in sequence, format, and length.
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Because the subprogram is now returning vehicle information, the DISPLAY statement must be modified as shown
below:

*

WRITE TITLE
/*** PERSONS WITH 30 OR MORE DAYS LEAVE DUE ***
[***  ARE MARKED WITH AN ASTERISK by /4
DISPLAY 1X'//[N AM E' NAME
1X'/IDEPT" DEPT
1X’/LVIDUE' LEAVE-DUE
v #MARK
1X'IIMAKE' #MAKE
1X'//IMODEL" #MODEL

1. Check PGMO1 and correct any errors.
2. Run PGMOL1.
3. Stow PGMOL1. Close PGMO1.

End of Session 7.
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